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1 Basics

1.1 General Structure of the Views

Camera Bar/Ca

Camera Bar/Camera Group Bar
Selection of all cameras or
camera groups with sorting
functions, switching between
cameras and groups

Device Bar

Home View

View History

Forward/backward X
Function and

Context-Sensitive Control Buttons

Selection of Views



General Structure of the Views

era Group Bar

Histogram

Camera Display Area
Single, groups as grid or
graphic view

Alarm Bar
Chronological list of all
event recordings

Hyperlink-Funktion

Execution of pre-defined functions, Edit Mode

such as home automation control For Grid, Graphic and Info
via HTTP requests/MxMessages or views

display of weather station website
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1.2 Camera Groups

Asurveillance area is divided into different areas, which contain the cameras.

The cameras of these areas are combined into group views. They always provide an overview that
allows you to quickly grasp the current situation.

This simplifies navigation and - in case of an alarm, you are quicker to access the relevant cameras.



Camera Groups

The easily customized Graphic, Grid and Info views are available for displaying the camera groups:

Info View

Grid View

Graphic View
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1.3 Camera Group Bar and Camera Bar

Quick selection of camera groups or individual cameras and fast switching between views.

Show Bars
Click/tap on the
frame border to open
the group bar or the
camera bar

10

Sort Display
Alphabetically or by custom sort order

Switch from Group Bar to Camera Bar
Click/tap on the upper frame border

Camera Images

Cameraimages are reference images, which
are created when adding the cameras. This
allows identifying the cameras independent
of the current illumination of the area

Sort Display
Alphabetically, by IP address or
custom sort order



Camera Group Bar and Camera Bar

Switch View
Mouse-over shows these icons: Select Group
Graphic view Single click or drag&drop
Grid view into display area
Show on 2" Monitor
Double-click
Adjust Bar Size
Drag the lower part of the
frame
Select Camera
Single click or drag&drop into
display area
Show on 2" Monitor
Double-click
Switch View
Mouse-over shows these icons:
Live view

Playback view

11
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1.4 Alarm Bar

Indicates if events lead to an alarm or if visitors rang the doorbell - regardless of whether or not
the bar is hidden at the moment.

Filter Display
By camera (all, single,

Alerting group)

Ringing

Instant Playback

Switch View
Mouse-over shows these icons:
Grid view

Playback view —

Instant Playback

12



Alarm Bar

Show Alarm Image Maximized in
Filter Display Window
By event type Single click

Show Live Image on 2" Monitor
Double-click

Hide Alarm bar

Detect Events Pull down the upper frame
New alarms are displayed even if the bar border

is hidden: Bar turns red (alarm) or green

(ringing)

Show on 2" Monitor
Double-click opens Instant
Playback on 2" monitor

_

13
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1.5 Grid View

Focus Window
Drag&drop cameras from the

grid or the camera bar into
the focus window.

Switching and
Control Functions
For camera in focus
window

Device Bar

Show Maximized Within Window
Single click on a camera image

Show on 2" Monitor

Double-click

14



Grid View

Camera/Group Bar

Alarm Info Bar
Mouse-over displays bar,
shows the last 25 alarm
images (when moving
the mouse pointer over
the bar)

Histogram

Live Images
of the cameras in this
group

Alarm Bar (Hidden)

15
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16

1.6 GraphicView

Camera/Group Bar
Bandwidth Header Bar (hidden)
Temporary adjustment of the
displayed image size/quality.

Ground/Floor Plan
Cameras can be posi-
tioned on ground/floor
plans as in reality.

Device Bar

Camera Icons

With adjustable angles
of view, change color
to red or green upon
detecting alarms.

Switching Functions

Use icons to switch functions, such
as opening a door. Also shows the
status: Door is still open.



Graphic View

Multiple Cameras
Represents several cameras on one
spot, e.g.,on a pole.

Alarm Bar (Hidden)

Environments/Projects
Set up several environments
for accessing the cameras
from separate locations
with different bandwidths
and allows saving/loading
projects.

Camera Groups
Click/tap on icon to
open the corresponding
Graphic view.

Histogram

Temporarily Show Live
Image

By mouse-over, drag&drop
onto plan to make image stick
temporarily.

Red indicates: A camera has

detected an alarm.

17
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1.7 Working With Different Network Environments

Automatic adjustment of image size, image quality and frame rate depending on selected environment.
This is done by the camera, independent of the Live view. The same applies to stored images, which
have been reduced in size by the camera before transmission.

Home

\¥/'

Good Quality
House camera

Access to gas station cameras from home using DynDNS access via Internet (low bandwidth)
Direct access to home cameras (high bandwidth).

Home

Adjusted
Quality
Home camera

Access to home cameras from gas station using DynDNS access via Internet (low bandwidth)
Direct access to gas station cameras (high bandwidth).

18



Working With Different Network Environments

Adjusted Quality
Gas station camera

Gas Station
I /_
-
Gute Qualitat
Kamera Tankstelle
Gas Station

19
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1.8 Licensing

Industry-specific solutions and special functions, such as the integration of cash point systems are subject
to licensing.

Activate Licenses

Enter a valid activation ID and
specify the number of licenses to
be installed on this computer.



Licensing

License Management
List of all licenses that have been
activated on one computer.

21
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22

2

2.1

Highlights Instant Selection
Drag&drop from camera bar.

Unique Usability Concept

Show maximized
within window
Single click

Show fullscreen

@ Double-click

If additional monitor is attached:

Show on 2" monitor

Double-click




Unique Usability Concept

Switch View
View selection using mouse-over icons
in the camera bar.

Instant Selection
Drag&drop from tiles into
focus window.

23
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24

Instant Selection
Drag&drop from group bar.

i Navigate
Home View Select view or camera using
Browse navigation button.
Through the view
history.



Unique Usability Concept

Switch View
Select view using mouse-over icons
in group bar.

Open Other Group
By clicking in Grid view.

Switching Functions
Use switch icons to control
functions.

Switch View
Select view using mouse-over
iconsin Alarm bar.

Icons in All Views For Adjusting And Selecting
Settings:
Zooming, sorting and filtering:

Image settings and volume:

25
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Device Bar
Clearly Structured Display
Of all cameras and groups in
list mode.

Quick Search
By cameras and groups

Simple Renaming
Of cameras and groups by
overtyping the name.

MxThinClient Integration

Clips & Recordings

Direct access to recordings
without adding the camera
to MxMC.

Managing Cameras and Groups
) cait .
Delete

Adding Cameras Create Groups

Manually or by using Bonjour

26



Unique Usability Concept

Easy Sorting
Drag&drop from within the list.

27
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2.2 Camera Groups

Grid View For Grouping According to Several Criteria: By location, by function, ...

Group functions
For example, opening doors.

Graphic view for positioning as in reality: perfect overview

28



Camera Groups

29
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2.3 Staying Informed Everywhere and in All Views

frrrnnnnnnnnnnn

NEREERRRENNRENE Parking — 28 Sek. Entrance — 30 Sek.
frnrnnnrnnnnnnnnnnnnnnnnnRnRREnRIIIIIILIILRRnLIR1

Show New Alarms
Red upon alarm trigger, green upon ringing.

Show New Alarms
Bar beneath live image turns red or green if the camera detects an alarm.
Move the storage card slider to the left to see the last alarm image.

30



Staying Informed Everywhere and in All Views

Chronological Ordering of Alarm Filter Display
Images By camera
By group
By event type

31
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2.4 Convenient Search and Analysis in Player Means Fast Results

Fast and Simple Operation

High-speed playback with up to 60x the regular speed

Camera selection Select playback mode

By drag&drop

Search for time/date Quick positioning on

desired date/time

Play Precise positioning
Search 30 seconds forward/
backward from time of
current image (only when
accessing recordings directly
on a file server).

Play One image for-

ward/backward
Up to 60 times

playback speed

32



Convenient Search and Analysis in Player Means Fast Results

Research Multiple Cameras for a Specific Point in Time

One of the parking lot cameras has detected an event at 8.30 pm. What did the other cameras
record at that time?

Currently displayed time o

Difference to reference time

o Click on pin button to set the reference time.

o Drag&drop cameras from camera bar one by one to position them on the reference time.

33
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2.5 Grid Playback - Investigating Entire Camera Groups

Browse the Recordings of Entire Camera Groups Synchronized By Time

o Use the timestamp in the focus window or the calendar slider to set the time.

All cameras jump to the event image that is closest to
the specified point in time. The timestamp beneath each
camera image shows the time and date of the image. The
difference to the reference time is shown at the right.

34



Access to Stored Images - Easily Customized

2.6 Access to Stored Images - Easily Customized

Depending on the requirements, you can configure each network environment to access the recordings
via the camera or directly on the file server.

0 Remote player: Access via camera
In local network or remotely

Advantage: Camera can adjust the image size, frame rate and image
quality of the video stream to the available bandwidth

=

§
(2

Player: Direct access on stored images
In local network

Advantage: Faster, since it does not put any load on the camera.

35
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2.7 Instant-Player - Research from Anywhere

Instant playback of event recordings for fast results - in the Alarm bar or the Research, Grid or
Graphic views.

Alarm Bar

Research View

Grid View

Graphic View

36



Export List - Flexible Export of Video Clips

2.8 Export List - Flexible Export of Video Clips

Export of the entire video to get an overview or export of an image section into various formats (mxg,
avi, etc.). The new export feature supports the flexible export into different video sizes and image rates
independent of the original format, it also supports virtual PTZ views as well as the transformation
of a 360-degree full image into a surround view, a panorama view or a customized view.

Mark recording for
export.

O

Drag&drop the clips into the
Export bar one by one. Alarm
bar automatically switches to
the Export bar. Use drag&drop
to change the clip sequence.

Click on Export
and set the export
parameters.

37
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2.9 Playback Analysis: Automatic Post Video Motion Analysis

The automatic Post VM analysis provides a high-speed search mechanism with time-lapse feature to find

2.10 Plugins: Interface for Third-Party Products

38



Playback Analysis: Automatic Post Video Motion Analysis

special motion events in all recordings.

39
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2.11 Retail System - POS Terminals With Integrated Video Surveillance

With the Retail system, all cash transactions can be linked to the video recording of transactions. Such a P(




Retail System - POS Terminals With Integrated Video Surveillance

)S system with integrated video surveillance makes it easier to locate and check suspicious activities.
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42

2.12 Histogram With MxEventStatistics

The Histogram bar is a fast and graphic method to find irregularities and the corresponding informa-
tion. This perfect tool provides the fastest overview using the camera’s internal database, without
the need of an additional computer.

Manual change

Overview area of time range

Filter: By event type or camera/
group/all cameras Zoomed

area

By dragging a marker, the Manual change of

L - time range Only show events
recording in the Playback view for which record-
is positioned accordingly ings are available

Granularity
on/off Set pre-defined

or custom zoom



Action Log (User Log)

2.13 Action Log (User Log)

MxMC can log any action, such as starting playback or export actions, activating the sound, etc. This
means that you can log all user actions and thus deliver the entire chain of events for legal purposes.

Entries can be sorted by time,
user or actions, for example. Search function

43
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2.14 Image Adjustment

Hemispheric cameras generate 360° images. In order to get naturally-looking images, MxMC can
correct these images. This applies to both live images and recorded images.

44



Image Adjustment

45
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2.15 Panorama Correction and Auto Flip

46



Panorama Correction and Auto Flip
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2.16 User Management

Individual Rights Management

Only the “Staircase” camera group has been unlocked for the “Reception” user.

Temporarily Unlock Functions

”Reception” user

Use Supervisor PIN to unlock
other camera groups.

48



User Management

User can temporarily access all
camera groups.

49
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2.17 Multi-Monitor Capability

Double-click

Multi-Monitor System Without Any Costs for Additional Software

50

Two Monitors

Live image shown on':



Multi-Monitor Capability

"4 monitor.

Several Monitors/Monitor Wall
Monitors are recognized automatically and
can be selected and arranged as needed.

51
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2.18 Hyperlink Support

Execution of pre-defined functions, such as display of weather station website or home automation
control using HTTP requests or MxMessageSystem.

Show weather station website

OO

Open/close blinds.

2.19 ONVIF Support Coming soon

MOBOTIX is ONVIF member since December 2014. MxManagementCenter allows integrating and
using ONVIF-compatible video sources.

52



Intelligent Configuration Management

2.20 Intelligent Configuration Management

Simple management of the system configuration using the intelligent configuration and sort bar.

All Relevant Settings for the Selected Function in One Spot

) ) ) . All settings for configuring basic
Configuration: Basic Settings settings

53
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All Settings of the System/the Group at One Glance

Display of all settings of one or more cameras for the selected function
and intelligent sorting by profiles.

Select function

54



Intelligent Configuration Management

Simple Configuration Changes of One or More Cameras Using Drag&Drop

Adjust arming of one camera by
dragging it to a different setting.

55
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3 Details

3.1 System Requirements

Mac OS X:
Mac 0S X 10.9 or higher, processor with at least 2 GHz, min. 2 GB RAM, graphics adapter with OpenGL
V2.1 support.

Windows:
Windows 8 or higher, processor with at least 2 GHz, min. 2 GB RAM, graphics adapter with OpenGL
V2.1 support.

Integrated MOBOTIX video sources:
Camera software release 4.3.2.77 or higher.

For more information on system requirements and other important information on the available
MxMC releases, please read the corresponding release notes on www.mobotix.com > Support >
Software Downloads.

3.2 Initial Operation of MxManagementCenter

3.2.1 Adding Cameras

Adding Cameras When Starting MxMC for the First Time

When starting MxMC for the first time, the configuration wizard opens and automatically starts
searching for MOBOTIX cameras. The number of found cameras is shown next to the Add button

. This number is updated automatically if the number of MOBOTIX cameras on the network has
changed (i.e., by connecting new/disconnecting existing cameras).

56



Initial Operation of MxManagementCenter

1. Clickon Add Devices . The cameras are displayed either in a list or as tiles. Use the List
and Tile buttons to change the display mode.

Possible camera statuses: o

. : Camera cannot be reached

. : Camera not in the same network as the computer
. : Camera software is not up-to-date

. : Camera is password-protected

2. Select camera (use CMD-click on a Mac or CTRL-click on Windows to select several cameras):

. : If the camera is password-protected, click on Edit User and Password
and enter the user name and password.

. : If the camera is in an invalid network, click on Edit Network
Settings  and select automatic IP address assignment or enter a fixed IP address.

3. The number of selected cameras is shown near the Next button o Move to the next page
and click on Finish

Hint:

You can also open the configuration wizard from the menu later on.

57
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Adding Cameras to a Running System

Open the device bar. The device bar is available in all views on the left side of the program window.

1. Activate the edit mode by clicking on ﬂ and then on [g@ at the bottom of the device bar. The
Add dialog opens.

a) Adding cameras in the local network:
All cameras and door stations in the local network are detected automatically.
1. Clickon .The Installation Wizard opens and lists all cameras that were found on the local
network.
2. Select the camera you want to add (use CMD-click on a Mac or CTRL-click on Windows to
select several cameras).

3. Specify a user name and a password. Click on to do so. When multiple cameras have been
selected, all of these cameras will get this user name and password.

58



Initial Operation of MxManagementCenter

4,

Click on and then on Finish. All new cameras are shown in the device bar in the Camera
section and you can already see the live images of the cameras.

You should now complete the data for the individual cameras. Open the Camera Configuration
dialog for this purpose. To open the dialog, you can either right-click onto individual cameras
oryou click on the icon, which is shown if you position the mouse pointer over the camera
name. The Camera Configuration Dialog opens. Complete the camera access data and the
network data. Set up the alarm notification as described in section 3.2.5, «Setting Alarm Filters
and Alarm Notifications».

Close the dialog once you have completely filled in the data in the Camera Configuration
dialog. Then deactivate the edit mode of the device bar by clicking on

b) Adding cameras manually:

Cameras outside of the local network (e.g., on the Internet) need to be added manually.

1.
2.

Clickon  .The Camera Configuration dialog opens.

Enter the camera access data:

« Name: Enter a descriptive camera name.

« URL:IP address of the camera.

« Remote URL: To access the camera from outside of the local network, you can enter the
corresponding external address of the camera (such as a DynDNS name). Make sure that
you also activate the Remote option.

« User name, password: Enter the user name and password of the camera.

Complete the network data and set up alarm notification as described in section 3.2.5, «Setting

Alarm Filters and Alarm Notifications».

Close the dialog once you have completely filled in the data in the Camera Configuration
dialog. Then deactivate the edit mode of the device bar by clicking on

59
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3.2.2 Creating Camera Groups

You can combine individual cameras into camera groups. For example, you can combine all came-
ras situated on the same floor in one group. This allows checking on entire surveillance areas at
one glance and - in case of an alarm, you are quicker to access the relevant cameras.

60

Activate the edit mode by clicking on ﬂ and then on at the bottom of the device bar.
Thenclickon . The Group Configuration dialog opens.

Enter a group name and - if desired - add an image or an icon that will be used to represent
the group in the group bar later on. To do so, click on the gray field and select one of the pre-
defined icons. If you want to use one of your own images, click on Custom.

You can add an information page to a camera group in order to show special instructions for
this camera group, for example. Move the slider to the right until you reach the position
. Click on the arrow in the gray field and select the file you want to use.

Max. frames per second: If a very large number of cameras is displayed in the Grid view, the
performance may decline. To avoid this, you can limit the frame rate of the live images within
the grid frames. Note that this limit does not apply to the camera displayed in the focus window.
Select the desired frame rate.

Close the dialog once you have completely filled in the data in the Group Configuration dialog.
Then deactivate the edit mode of the device bar by clicking on



Initial Operation of MxManagementCenter

Adding Cameras to a Camera Group

After you have added cameras and created camera groups, you now need to assign cameras to the
proper groups.

1. Activate the edit mode by clicking on ﬂ at the bottom of the device bar.

2. Dragthe desired camera from the Cameras section to the desired group in the Camera Group
section.

Note: If you have assigned a camera to one group, you can copy this assignment to other
groups by dragging the assignment from the first group to other groups.

3. Onceyou have assigned the cameras to the desired groups, you can deactivate the edit mode
by clicking on

3.2.3 Changing the Data of Many Cameras

The Multi-Camera Configuration dialog allows changing authen-
tication data used by MxMC and the environment settings of many
cameras in one step.

Activate the edit mode by clicking on ﬂatthe bottom of the device
bar. Select the desired cameras (SHIFT-click or Mac: CMD-click,
Windows: CTRL-click). Right-click on one of the selected cameras.

Status Display

When opening the dialog, the application shows the current settings
of the cameras. If one option has several different settings, the
field is labeled with “Multiple Values*.

Field type Current status

l:l All cameras have the user name admin.
l:l The cameras have different user names.

This settings has been activated for all cameras.
This settings has been deactivated for all cameras.

The cameras have different settings.

“HiRes* has been set as bandwidth setting for all cameras.

[ Multiple Values ] ¢| The cameras have different values.
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Changing the Settings

As opposed to the configuration of only one camera, you can revert the changes that have not been
stored. Depending on the field type, you can use different methods.

If you change the text field of a setting, such as User Name, a small

| cross appears on the right-hand side. Click on the cross to reset

[ Multiple Values ] |

the entry to its original value.

When closing the dialog, the previous setting will be restored.

If you select Multiple Values in a selection box, closing the dialog

will restore the previous setting.

Notes on the Settings

Although the fields and settings in this dialog are identical to the Camera Configuration dialog,
there are a couple of special hints that will help to properly edit the contents of the fields described
in the following:

62

Recording Path:

Local Path: The Local Path option can be selected for all cameras. Note that you will need
to enter the paths individually for each camera in the Camera Configuration dialog (see
section 3.2.9, , Setting Alarm Filters and Alarm Notifications®).

<Defined Recording Path>: If you select a previously defined recording path (see section 3.2.9,
»Setting Alarm Filters and Alarm Notifications“), MxMC automatically searches the device
directory for each camera. The search has been completed if the progress bar is replaced by
OK. If you close the dialog beforehand, you will have to enter the device directory for each
camera in the Camera Configuration dialog.

Alarms:

The Alarms option activates or deactivates the alarm notification for all cameras. Note that
you will have to set the alarm settings for the event types individually for each camera. Use
the Camera Configuration dialog to do this (see section 3.2.9, ,Setting Alarm Filters and
Alarm Notifications®).



Initial Operation of MxManagementCenter

3.2.4 Adding Clips and Recordings

Adding Clips

You can use MxMC to play back exported MxPEG clips.

1.

Activate the edit mode by clicking on ﬂ and then on at the bottom of the device bar.
Clickon .TheLoad Clips dialog opens.

Select the desired MXG file and click on Open. The clip appears in the device bar in the Clips
& Recordings section.

Theicon indicates that a clip file cannot be located anymore.

Adding Recordings

You can directly access recordings that are saved on afile server,
even if the respective camera is not integrated in MxMC.

1.

Activate the edit mode by clicking on ﬂ at the bottom
of the device bar. To import a recordings folder click on
and then on

Select the desired folder and click on Open. The sequences
appear in the Device bar in the Clips & Recordings section.

3.2.5 Creating Groups for Clips und Recordings

Clips and recordings can be compiled into groups and subgroups
to better organize the clips and recordings.

1.

2.
3.

Activate the edit mode by clicking on ﬂ and then on at the bottom of the device bar.
Clickon  tocreate agroup. A new group will be added. By default, this group will be called
“New Group.”

Click on the selected new entry and enter the desired name.

Drag and drop the desired clips and recordings onto the group.

Theicon ndicates that there are no clips or recordings in the group.
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3.2.6 Adding a MxThinClient Device and Activating Live Images

You can now also integrate one or more MxThinClient devices in MxMC. For example, you can add
an additional display unit (monitor or TV) by double-clicking on the camera live images of P3 and
Mx6 cameras from MxMC.

Adding an MxThinClient Device

1. The MxMessageSystem needs to be activated in the settings and you need to make sure that
the Broadcast port and Password fields contain the same settings as you configured in
the MxThinClient because the camera live images are switched on with MxMessageSystem
(Mac: MxManagementCenter > Settings > MxMessageSystem; Windows: File > Settings >
MxMessageSystem).

2. You also need to make sure that the MxThinClient and the computer running MxMC are syn-
chronized via the same time server.

3. Clickon .toadd a MxThinClient. The MxThinClient Configuration dialog box opens. Complete
the following entries:
¢« Name

The name for the MxThinClient that is shown in the Device bar. You can freely select the
name and it does not have to be unique.

o Serial Number
The serial number is the factory-defined IP address that is printed on the housing of the
MxThinClient. Remember that you need to enter the number correctly because it represents
the address at which the MxThinClient is accessed in the MxMessageSystem.

« URL (optional setting)
The IP address or DNS domain name at which the MxThinClient can be accessed.
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User Name and Passwor (optional setting)
The access data on the MxThinClient that you entered when installing the MxThinClient.

Display Resolution

Here you can select the resolution that the camera’s live image uses when data is sent to
the display unit. If the display unit does not support the desired format, the MxThinClient
displays the message Resolution not supported on the monitor.

Camera Display Time

You can select how long the armed camera’s live image is displayed before the MxThinClient
continues with displaying the normal sequence of configured image sources.

If you select Unlimited for the display length, the camera’s live image is displayed until the
MxThinClient receives a new command, such as when an event is triggered when it receives
MxMessages from other cameras/devices in the network.

If you want to stop the display of the camera’s live image before the set display length
elapses, click on the icon. It appears when you move the mouse pointer over the name
of the MxThinClient in the Device bar.

4. Close the dialog box once you have completely filled in the data in the MxThinClient Configuration
dialog box. Then deactivate the edit mode of the device bar by clicking on

Activating Camera Live Images

There are two options for activating a camera live image on an additional display unit:

« Double-click: Double-click on the desired camera live image.

The images are displayed directly on the display unit connected to the MxThinClient if there
are not any other monitors connected to the MxMC computer and the MxMC is only connected
to one MxThinClient.

If there are more than one monitors connected to the MxMC computer or several MxThinClients
connected with MxMC, you are prompted to select the desired display unit for displaying the
images.

« Bydragand drop: Drag and drop the desired camera live image from the Camera bar or from
the Device bar onto the desired MxThinClient in the Device bar.

Notes:

The MxThinClient section is only visible in the Device bar if a MxThinClient has been integrated.

You need to possess administrator rights to add, manage or delete a MxThinClient.
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3.2.7 Setting Up Group Views

Using a Ground/Floor Plan for the Graphic View
You can position the cameras of a group on a ground or floor plan when using the Graphic view.

1. Activate the edit mode by clicking on ﬂand thenon atthe bottom of the device bar. Then
clickon .The Group Configuration dialog opens.

2. Move theslider to the right until you reach the position.

3. Click on the arrow and select the file with the ground or floor plan.

Adding Information for a Camera Group

You can add an information page to a camera group in order to show special instructions for this
camera group, for example.

1. Activate the edit mode by clicking on ﬂand thenon atthe bottom of the device bar. Then
clickon .The Group Configuration dialog opens.

2. Move theslider to the right until you reach the position.

3. Click on the arrow and select the file you want to use.
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Assigning Group Functions

In the Grid, Graphic and Info views, you can use group functions to make an announcement, switch
the light or open the door for one camera of the currently selected group.

[ ]

The two functions Switch Light and Open Door can be assigned to multiple cameras. This allows
you to switch multiple lights or open multiple doors at once with a single click.

To assign group functions, proceed as follows:

1. Activate the edit mode by clicking on ﬂ at the bottom of the device bar.

2. Move the mouse pointer over the group name. Three icons appear. Clickon . The Group
Configuration dialog opens.

3. Assign the desired functions to the cameras by activating the corresponding checkboxes.

4. Onceyou have defined all group functions, you can deactivate the edit mode by clicking on
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Setting Additional Options for the Grid View

You can adjust the layout you defined when creating the camera groups directly in the Grid view
later on.

Activate the Edit mode o Several sliders appear in the control bar.

68

By default, the auto grid mode is used in the grid layout. In auto grid mode, MxMC always
tries to distribute the available space as good as possible according to the specified grid para-
meters, such as the aspect ratio of the tiles (4:3, 16:9, 8:3), the size of the focus window and the
number of cameras. When you change the window size, the grid layout adjusts automatically.
The following sliders are available to adjust the grid layout:

: Format of the camera images and the focus window (4:3, 16:9, 8:3)
: Size of the focus window (1x, 2x, ..., 8x the size of the camera images)

: Maximum number of cameras

To prevent the automatic layout adjustment, freeze the grid‘s current layout by clicking on

In manual mode |, you set the size of the individual tiles and their position based on the
selected format of the camera images (4:3, 16:9, 8:3). In contrast to auto grid mode, the layout
is not adjusted automatically in manual mode. To switch from auto grid mode to manual
mode, move the slider  to the right until you reach the position . The following sliders
are available in manual mode:

: Format of the camera images and the focus window (4:3, 16:9, 8:3)

: Maximum number of cameras
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Move the sliders to the desired settings. To move a tile to a different position, move the
mouse pointer over the tile. Click on and drag the tile onto the desired position. For
better orientation, a blue frame indicates the target position.

To set the size of a tile based on the selected format, move the mouse pointer over the
border of the tile until a double arrow is shown. Drag the tile to the desired size.

. : Use this button to switch the focus window of the current group on or off.

To close the Edit mode, click on

Setting Additional Options for the Graphic View

Positioning Cameras on the Plan

When opening the Graphic view of a camera group for the first time, all cameras of the group are
shown as anicon atthe right-hand border. To place the icons at their positions according to the
floor plan used in the Graphic view, do the following:

1. Activate the Edit mode e Move the mouse pointer over the icon. Click on and drag the
icon onto the desired position.

2. Deactivate the Edit mode to save the settings.
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Editing Camera Icons

You can change the icon size and rotate the icons to reflect the cameras’ viewing direction and angle
of view..

70

Activate the Edit mode oand click on a camera icon. Rotate the icon’s view direction indicator
by dragging it with the mouse to its desired angle 3.

To change the icon size, drag the corners of the icon’s bounding box as desired e

To change the angle of view, click on the camera icon and rotate the mouse wheel until the
desired angle has been reached.

Deactivate the Edit mode to save the settings.
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Positioning Other Camera Groups on the Floor Plan

You can position shortcut icons to additional camera groups on the floor plan of a camera group.
This camera group icon turns red or green (ringing), if one of the group’s cameras detects an alarm.
Click on the group icon to open the Grid view of the camera group.

M —
/

1. Activate the Edit mode o and drag the desired camera groups from the group bar onto the
floor plan 3.

2. Deactivate the Edit mode to save the settings.

Positioning Controls on the Plan

If a camera is, for example, connected to a door, simply drag the corresponding control icon onto
the ground or floor plan and click on the icon to control the feature. This is helpful if you want to
control the door switching features of a camera close to its position on the plan, for example.
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1. Activate the Edit mode 0

2. Right-click on the desired control function and drag the icon onto the ground/floor plan o
3. Deactivate the Edit mode to save the settings.

3.2.8 Adding and Managing Users

If you want to set up users with different rights for MxManagementCenter, you need to add these
users first. For this purpose, the application differentiates between the “administrator” and “user*

roles. While the administrator has all rights, you can assign the rights for users depending on the
functions they need.

In order to add a user, you need administrator rights.

1. Click on the User management icon in the header bar.

2. clickonadd @.
3. Enter the user name and a password e and confirm the password.

4. Use the Expires option o, if you want the user to change the password at regular intervals.
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5.

If the user is to change the original password upon the next login, select the Force Change
on Next Login option .

Note: Activating this option automatically grants the user the ,,Change Password“ right, even
if it was disabled before.

6. The Force Complex Password option o ensures that users can only set secure passwords.

A secure password has at least eight characters, consists of lowercase and uppercase letters,
at least one special character, one digit and one character. Furthermore, it cannot be one of
the last thirteen passwords used on this user account. If you are trying to set a password that
does not meet the criteria, a red frame around the text field will appear @2.

Use the Active option to enable the new user immediately or later on. At the same time, you
can set after how many minutes of inactivity this user will be logged out automaticallyé

By default, a new user has the rights to execute all functions. Deactivate the rights that should
not be available to this user in the User Rights section. o
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Assigning Supervisor Passwords to Functions

Certain situations may require users to execute functions for which they usually do not have the
rights. These functions can be made available temporarily using a supervisor password.

1. Click on Supervisor and enter a password o

2. In addition, you can specify after how many minutes of inactivity this user will be logged out
automatically (Timeout é).

Note: While a recording is being played back in Playback view or in Grid Playback, MxMC does
not automatically terminate the supervisor mode after the specified period of time.

3. Select the functions that can be accessed in supervisor mode e

Changing the Rights

Click on the user whose settings you want to edit. Then configure the rights by setting the appropriate
switches in the User Rights section.

Deactivating Users

If - for security reasons - you want to prevent a particular user from logging in, you can deactivate
that user. This prevents the user from logging in. To do this, select the user and deactivate the
Active option.

Deleting Users

Click on and then on next to the user you want to remove.
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3.2.9 Setting Alarm Filters and Alarm Notifications

Setting Alarm Filters

Events that lead to an alarm will change the background color of the alarm or the alarm info bars
to red. Use the Camera Configuration dialog to specify the event types on the cameras that should
trigger an alarm.

1. Toopen the dialog, activate the edit mode by clicking on ﬂ at the bottom of the device bar.
Then, you can either right-click onto individual cameras or you click on the icon, which is
shown if you position the mouse pointer over the camera name.

2. Click on Alarms to adjust the settings. The Alarm Events dialog opens.

3. Select the event types that should create an alarm.
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You can select a weekly profile for every event type that should trigger an alarm. As long as no other
weekly profile has been selected, the setting is valid from Monday 00:00 to Sunday 24:00.

1. Tocreate new weekly profiles, clickon . The Weekly Profiles dialog opens. Several predefined
profiles are available, such as the Weekend profile (Saturday 00:00 to Sunday 24:00).

2. To add a profile, click on . Enter a description. Highlight the desired active times in the
table. You can resize an active time block by clicking on the time block and then moving the
borders accordingly It is also possible to move a block. Click on the block to select it, then drag
the block to the new position. To delete a time block, click on

3. Thedescription of an existing profile can be changed. Right-click on the description and overwrite it.

4. To select a weekly profile, click on the Weekly Profile dropdown list next to the event type
and select the desired profile.

5. To easily invert the settings of the weekly profile, simply click on the calendar icon. For example,
if you have created a profile with opening hours and would like to activate the alarms for the
closing times, simply activate Invert and the profile is used in inverted fashion.
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Setting Alarm Notifications

In addition to the event notifications in the Alarm bar or the Alarm Info bar, you can set up an alarm
notification or alarm sound that signals new alarms. To do so, open MxManagementCenter >
Preferences and click on Netifications.

1
2
3.
4

. Activate the Alarm Notification option to get a message when a camera is sending an alert.

. Select the desired melody from the list.

Select the duration and the volume of the alarm sound.

If you do not want to hear an alarm sound, set the volume to “0”.

Active Alarm Message

If a camera detects an event that leads to an alarm, an alarm message pops up if Notification has
been enabled.

Click on to see the live images of the camera (e.g., if
the alarm popped up a couple of seconds ago).

To open the Playback view and to see the recording,
clickon

To close the message, click on
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3.2.10Licensing

Industry-specific solutions and special functions, such as the integration of cash point systems are
subject to licensing.

Activating Licenses

After receiving the Activation IDs, activate them in MxMC. To do this, open the License management
(menu Windows > Licenses) and click on Activate licenses.

1.
2.
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Enter a valid activation ID as well as the number of licenses that will be installed on this computer.

Click on if you want to license an additional product. Enter the corresponding activation
ID in the new line and enter the number of desired licenses.

Click on to delete a line.
When you are finished entering all activation IDs, click on Activate.

o Activation successful

If activation was successful, you can return to License management or log out for the
changes to be applied.

« Activation failed (no Internet connection)

MxMC connects to the license server for activation. It needs to establish an internet con-
nection. If there is no internet connection, an error message is displayed in which you can
save an offline request file (*.lic).

A partner/installation technician can generate a capability response file (*.bin file) using
this file. Once you have received it, open the Activate licenses window (menu Windows >
Licenses > Activate Licenses) and click on Load Capability Response File.

If the capability response file was successfully loaded, you can return to License management
or log out for the changes to be applied.
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License Management

You can view a list of all licenses that have been activated on this computer in License management.
Click on Windows > Licenses to open the License management.

Name Explanation

Product Name of the licensed function.

Expiration The license is either valid indefinitely or it expires on a specific date,
which is listed in this column.

Quantity Number of licenses that are activated for a product.

Device ID Unique identifier that is determined by MxMC for the used device. Note

the device ID and keep it accessible if you should run into any problems
during licensing.

Update

When launching the program, it does not automatically synchronize the licenses on the computer with
the license server. For this reason, you need to click on Update to reload the licenses from the server.

Note: You need administrator rights to activate or update licenses.
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3.3 Configuring and Securing the System

In the Configuration view, you can adjust various basic settings that are generally required to put
the cameras into operation. This includes, for example, the graphical configuration of exposure
windows and MxActivitySensor detection areas.

After the basic configuration of the system, you can check its security. The Wizards & Tools view
offers the Secure System wizard for this purpose. This wizard analyses camera security and assesses
their status with respect to common best practices. If test criteria are not fulfilled, measures are
indicated which are necessary to secure the cameras.

3.3.1 Configuring the System - Basic Settings
Open the Configuration View by right-clicking on the Navigation button. Select Configuration View.

O

In general, the Configuration view offers the possibility to make various basic settings on the cameras.
To do this, the view is divided into several tabs . With the control elements at the bottom s
changed camera settings of the tabs can then be permanently saved or the parameter values can
be reset to the factory settings. The settings in the Configuration view are made for one camera at
atime. The Configuration bar on the righté offers the possibility to change the settings of several
cameras of a group without having to switch the camera or the camera group.
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Topics of the Tabs

General
The general settings contain settings for operating the cameras, such as arming or frequency
of power supply.

Network

The network interface settings determine how the camera can communicate with the “outside”
world and how the camera can be accessed from outside of the local network. When changing
the parameter values, please note that the changed values are not automatically applied, as
in the other tabs of the Configuration view. For the changes to take effect, you must click

in the control bar (see also section ,Applying Modified Values®).

Time

Date and time on the camera can either be set manually, taken over from the computer or
synchronized with a time server. When using a time server, synchronization can be performed
via a time server on the Internet, a time server service on the local network, or another MOBOTIX
camera. In this case, the camera‘s time server has to be activated in the Admin menu of the
camera‘s web interface (Admin > Camera Administration > Time & Date > Use Camera as
Time Server).

Image
In this tab, you can define camera views, image and exposure settings for displaying live camera
images and create and edit user-defined exposure windows directly in the live image.

To do this, set the Exposure Window option to Custom and then click in the live image at the
bottom. Use the following actions to create and/or edit exposure windows:

Create exposure window  Create a window using the mouse pointer.

Left-click with the mouse pointer on the exposure window

Move exposure window . . -
P and drag it to the desired position.

Place the mouse pointer on one of the white drag points until
Modify exposure window  you see the icon. Left-click with the mouse and drag the
window, making it larger or smaller.

Delete exposure window Click on

Drag a window corresponding to the size and position to the

area that should be excluded from exposure measurement.
Exclude areas from

exposure measurement Click on the window and keep the mouse button pressed

until two icons appear. Click on to set the window as
an exclusion window. The window turns red.

Further information on the individual parameters can also be found in the quick help, which
is integrated in MxMC and can be called up by clicking on
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Recording
In this tab the most important recording settings can be made, as for example, the selection
of the recording mode or the recording speed.

MxActivitySensor

The MxActivitySensor is a camera-internal video motion detector that can identify the direction
of object movements as well as their size while blocking out any undesired interference (such
as trees swaying in the wind). By default, a MOBOTIX camera has a predefined MxActivitySensor
profile.

You can activate and deactivate this profile in this tab, change the name of the profile, adjust
the event dead time, define new and change existing detection areas. Click on a green detection
area of the live image. Use the following actions to create and/or edit detection areas:

Place the mouse pointer on one of the white drag points until
Modify detection area youseethe icon. Left-click with the mouse and drag the
detection area making it larger or smaller.

Place the mouse pointer on the detection area. Then left-click
Move detection area with the mouse to drag the detection area to the desired
position.

Clickon  and use the mouse pointer to rotate the detection
area clockwise or counterclockwise.

Rotate detection area

Switch to polygon mode by clickingon . You will see white
points on the corners. Drag the corner points to the desired
position. You can insert new corner points by right-clicking
on the white line or within the detection area. Right-click on
a dot to delete a corner point. Then click on

Change shape of
detection area

Delete detection window  Click on

Create additional Draw a new window using the mouse pointer.

detection window

Drag a window corresponding to the size and position to
the area that should be excluded from the analysis. Click on
the window and keep the mouse button pressed until two
icons appear. Click on to set the window as an exclusion
window. The window turns red.

Exclude areas from
analysis
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Controls in the Contral Bar

Resetting to Factory Settings
Click  toresetall parameters within the current tab to the factory settings.

Undoing or Repeating Changes
Click  toundothe last change. Click  toredo the last change.

Applying Modified Values

Normally, the changes in the Configuration view take effect when you enter or select a new
value. The changes made in the Network tab are not automatically applied because it could
potentially cause cameras to be unreachable. Instead the Apply Changes  icon in the Control
bar turns red, indicating that the changes on the network tab have not been applied yet. To
aplly them, click on

Saving Configurations

If parameter values are changed, the Save Configuration iconin the Control bar turns red.
Changes to the configuration are only stored temporarily. To ensure that the current settings
are used after the next restart, the changes must be saved permanently.

1. Click Save Configuration . Click Save in the confirmation dialog.

2. Ifyou do not want to keep the changes, click Discard. This discards the changes and restores
the last overall configuration that has been permanently saved.
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Changing Parameter Settings for One or More Cameras

You can enter parameters for a camera in the Configuration view. If you want, you can display the
parameters available for the other cameras in the group by viewing them in the Configuration Bar.
You can also change the settings of one or more cameras in the group, without having to switch to
a different camera or camera group.

First open the Configuration view and then the Configuration bar on the right side of the view o

Changing Parameter for One Camera

1. Click on the corresponding name of the parameter in the Configuration view e It turns yellow
and the Configuration bar shows all values associated with this parameter for this group @J.
The cameras are categorized according to the values of the currently selected parameter value.

2. Highlight the desired camera and drag it onto the parameter value you want to set. The des-
tination area turns yellow.

Changing Parameter for Several Cameras

1. If you want to change the value that is used by more than one camera, click on the parameter
selection boxo and select the desired value.
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3.3.2 Securing the System

The Secure System feature in the Wizards & Tools view helps administrators to increase the security of
their camera systems. It reveals possible points of attack and prevents unauthorized or unencrypted
access to cameras.

Open the Wizards & Tools view by right-clicking on the Navigation button. Select Wizards & Tools.

O

Verifying Settings for System Security

1. Select the desired camera or camera group in the Device bar or the Camera/Group bar. Click
Secure System. The following criteria will be checked:

« Usage of the “meinsm” password with standard or ONVIF user accounts on MOBOTIX
cameras: It is easy for cyberattackers to guess the standard “meinsm” password.

o Public Access enabled: A number of different camera functions can be used without password
when Public Access is enabled.

o HTTP Web Server enabled: When HTTP is used, user data such as passwords and images
will be transmitted via the network in clear text without any encryption.

2. Anew dialog will be opened, showing the results of the analysis for each camera in a table. It
will also indicate if cameras could not be checked, e.g. due to a connection error.

Not secured At least one test criterion has been identified as not being secured.
Software too old Please check the camera software and update it.

Please check the network connection to the camera and then

Connection error _
restart the security check.

This camera does not support this function and cannot be

Not supported . ="
secured using this wizard.

Secure The camera is secure; no further action is necessary.
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Secure System

1. Click Continue. For all cameras having the Not secured status, the system now displays which
of the three criteria have already been fulfilled. Security criteria that are not yet fulfilled, can
be secured directly in the dialog:

Changes the password of all user accounts on the cameras that
use the standard “meinsm” password. This also include ONVIF
users whose passwords have never been changed.

« Enteranew password and confirm it. A suitable password
has at least eight characters. It can consist of lowercase
and uppercase letters, digits and special characters (see

Password in the dialog box). If you type in a password that does
not meet these criteria, a red frame appears around the
text field.

« Theframe turns green once you have entered a valid pass-
word. Note that, when the wizard secures the cameras, it
automatically changes the password in the MXMC project
data accordingly.

Disables camera connections via an unencrypted HTTP and
configures the cameras to accept HTTPS connections only.

The TCP port and the SSL setting will be automatically updated
in the MxMC project data, if necessary.

SSL Encryption The TCP port will not be updated for cameras that are connected

via a remote URL. Therefore, when connecting via remote URL,
you may need to adapt port forwarding in your router accordingly.

Please note that different services, such as network messaging,
etc., will no longer work when you disable HTTP.

Disables password-free access to the web interface and the
APIs of the cameras.

Public Access

2. Click OK. The selected measures to secure the cameras will be performed. The security status
for the selected camera or camera group will be analyzed once again and the result for each
camera is displayed.
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3.4 MxManagementCenter in Day-to-Day Use

3.4.1 Working With the Grid View

Selecting a Group

1. Pull down the group bar.
2. Drag&drop a group onto the Grid view. Alternative: Click on the Group icon.

Showing a Different Camera in the Focus Window

[ ]

1. Drag&drop a camera from the camera bar or drag the live image into the focus window.
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Detecting and Editing Events
If a camera triggers an alarm, the Grid view shows this using several methods.

Alarm Bar

The Alarm bar contains events that lead to an alarm (red) or if visitors rang the doorbell (green)
- regardless of whether or not the bar is hidden at the moment.

1. Pullup the lower frame border to show the Alarm baro.

2. To acknowledge a new alarm, click on the event image. To acknowledge all alarms at once,
right-click the event image and select Confirm All é You can also mark events that are
importanttoyou ,soyou can play back only the important events later on.

3. Features of the Alarm bar:

« View the event recording directly in the Alarm bar using the Instant Playback. To do so,
move the mouse pointer over the event image. Three icons appear. Click on to start
the playback.

« Jump to the Playback view. Click on

+ Open the Grid view assigned to this camera. Click on

Hint:

Click into the live image or the recording to show this camera maximized within the window.
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Alarm Info Bar

New alarms are also displayed in the Alarm Info bar. The bar beneath live image turns red or green
if the camera detects an alarm @p.

Move the SD card slider to the left e This opens the Instant Playback with the last eventimage.
Drag the red counter along the bar to show the preceding images; the number in the counter
increases. Click on Playback é to see the recording for the corresponding event image.

Hint:
Click into the live image or the recording to show this camera maximized within the window.
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Controlling the Camera in the Focus Window

Use the controls at the bottom of the window to control the camera that is currently showing in the
focus window.

. : Zooming and Moving Image Sections
. : Select pre-defined image sections

. : Correct image distortion

. : Accept and end calls

. : Open door and switch lights

. : Show temperature

. : Show eventimages
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Switching Group Functions

Use the Group buttons in the command bar to switch group functions for a camera group (prerequisite:
group functions have been assigned in the Group Functions dialog, see section ,Assigning Group
Functions®). This means that you can switch the light, open the door or make an announcement
for a previously defined camera in this group, regardless of the camera currently displayed. You
can also assign the Switch light and Open door functions to several cameras in this group, so that
several lights can be switched or several doors opened with one click.

In addition, you can right-click on the group buttons to open the context menu in order to control
cameras that are not part of the current group. Before you can this, the cameras have to be set up
accordingly, i.e., the cameras need to be connected to door openers/light switches and have to be
configured properly.

Limit Frame Rate of Live Images

If a very large number of cameras is displayed in the Grid view, the
performance may decline. To avoid this, you can limit the frame rate
of the live images. Note that this limit does not apply to the camera
displayed in the focus window.

1. Pull down the group bar.

2. Right-click on the Group icon and select Frame Rate.
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3.4.2 Working With the Graphic View

Placing Individual Camera Live Images on the Ground/Floor Plan

If you also want to monitor individual live images in the graphics view, you can drag these live images
from the Camera bar or the Device bar onto the current Graphic view. You can place live images
either temporarily or permanently. Temporarily means that these live images will be removed if
you open a different view. You can then operate the camera live image - as in the focus window of
the grid view - with the switching and control functions at the bottom of the live image,also see
section ,,Controlling the Camera in the Focus Window*.

Note: If the live image was corrected for distortion in the tile afterward, this is also adopted when
playing an instant playback for the configured image mode.

Example: Drag&Drop from the Camera bar

Temporary placing:

Drag the desired camera from the Camera bar or the Device bar onto the Graphic view.
Permanent placing:

Activate the Edit mode o Drag the desired camera from the Camera bar or the Device bar onto
the Graphic view. To save, close the Edit mode.
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Detecting and Editing Alarms

If MXxMC detects an event that leads to an alarm, the Graphic view shows this using several methods.

Alarm Bar

The Alarm bar contains events that lead to an alarm (red) or if visitors rang the doorbell (green)
- regardless of whether or not the bar is hidden at the moment.

1. Pull up the lower frame border to show the Alarm bar o

2. To acknowledge a new alarm, click on the event image. To acknowledge all alarms at once,
right-click the event image and select Confirm All @g). You can also mark events that are
importanttoyou ,soyou can play back only the important events later on.

3. Features of the Alarm bar:

« View the event recording directly in the Alarm bar using the Instant Playback. To do so,
move the mouse pointer over the event image. Three icons appear. Click on to start
the playback.

« Jump to the Playback view. Click on

+ Open the Grid view assigned to this camera. Click on
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Camera Icons

If a camera detects an event, the camera icon turns red or green (ringing event). You can get a quick
glance at the situation observed by the camera by showing a small live image (move mouse pointer

over icon ) or by showing a large live image (click on camera icon). If a second monitor is
available, double-clicking on the icon will show the live image on that monitor. From the live image,
you can switch directly to the Playback view to check the alarm details.

You can also see the recording for this alarm directly in the Instant Playback. To do so, show the

live image and click on the bottom (date and time). The Instant Playback opens o Click on
to start the playback or move the mouse pointer over the image.
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Camera Group Icon
If you have positioned additional camera groups on the ground/floor plan, the name bar of the
group icon turns red or green, if a camera of that group detects an alarm @J§).

1. Move the mouse over the group icon in order to show the live image Ofrom the camera that
triggered the event.
2. Click on the bottom of the live image (date and time) to open the Instant Playback. Click on
to start the playback.
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Switching Functions

Switching Functions with Control Elements on the Floor Plan

For controls that you pulled onto the ground/floor plan, a simple click will execute the function
. At the same time, the icon shows the status of the function. If the door is not closed, for
example, the icon shows an open door icon .

Switching Functions Using the Control bar

By using the Control bar in the grid and graphic views you can switch a light, open a door or make
an announcement for one group camera and independently of the selected camera. In addition,
you can right-click on the group buttons to open the context menu in order to control cameras that
are not part of the current group.
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3.5 Searching in MxManagementCenter

3.5.1 Configuring the Access Mode

The program can access the stored images using two methods: Access via the camera or directly on
a file server, on which the recordings are stored.

1. Inthe menu, clickon MxManagementCenter > Preferences (Mac) or File > Preferences (Windows)
and select Recording Path. Create the recordings paths you want to use for directly accessing
the recordings on one or more file servers. For more details, see ,,3.9 Program Settings*.

2. Activate the edit mode by clicking on ﬂ at the bottom of the device bar. Then right-click on
the desired camera to open the Camera Configuration dialog.

3. Select the desired recording path efor every network environment o

4. Select the format e of the recordings: Use MxFFS, if the recordings have been stored in an
MXFFS archive. Use MxFileServer, if the recordings have been stored in the classic MOBOTIX folder/
file structure.

Hint:

If you want to add recordings from a hard disk that had been recorded by a camera that is not
in the system any more, you can set the recording path to Local Path and enter the recording
folder using drag&drop.
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3.5.2 Searching and Playing Back in the Research View
To open the Playback view, right-click on the Navigation button. Select Playback View.

O

General Playback View Controls

To search and play back recordings, you can activate Playback mode o

or select the date and time and then use the Previous/Next Image buttons ,to browse the
recordings or you can start the playback using the Forward/Backward Playback buttons

The playback mode is initially set to Event Recording @J. If you want to play back all recordings,
switch to Entire recordings ).

Browsing Recordings for Event Images
You can select the recordings according to these events:
« Eventimages: Only shows event images.
« Pre-event images: Shows only the first recorded image for each event.

« Marked events: Shows only the images, which had been marked as important before.

1. Inthe Playback view, select the Playback mode by right-clicking the button and selecting the
desired mode @J.

O

2. Browse the recordings using the and buttons. Beginning at the current event image,
these buttons show the previous or next event image @J.
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Browsing Recordings for a Specific Date and Time

If you have set up continuous recording for certain times and you want to check for events during
those times, for example, you can limit the search to these times. You can search for events at a
given time, by using time leaps or time-lapse playback.

Searching for a Specific Date and Time

1. Click onthe displayed date and time 0 and enter the date and time to search for.

2. Theeventimage jumps to the event in the recordings that is closest to the specified date and
time. Click on Playback

or

1. Click on the Calendar slider e The date and time will be shown above the slider. Move the
slider until you reach the date and time that is closest to the point in time you want to examine.
The eventimage jumps to the event in the recordings with the specified date and time. If such
arecording is not available, the eventimage jumps to the event that is closest to the specified
pointin time (in the direction of searching). In the latter case, the slider turns read the time
difference to the specified point in time is shown above the slider. Click on Playback
Hint: The farther away you move the mouse pointer from the slider, the more precise your
setting will be.
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Searching Several Cameras for Persons or Objects

Camera A is overlooking the gate and signals an event. The event image in the Alarm bar shows
a delivery truck driving through the gate. You want to know if the truck has also passed the area
monitored by camera B.

1. Move the mouse pointer over the event image to see three icons. Open the Playback view
mode by clicking on

2. Play back the recording (end of recordingo).

3. Drag&drop camera B from the camera bar into the Playback view.

[ ]

4. The playback automatically selects the recording that follows the end of camera A’s recording
. You can repeat this for as many cameras as needed.
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Investigate Multiple Cameras for a Specific Point in Time

You want to know if other cameras have recorded something at a specific point in time:

1. Set the reference time using the Pin button o
2. Drag&drop the cameras from the camera bar one by one 0

3. The application shows the event images of each camera that are closest to the specified point
intime.
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Limiting the Search Range for an Incident

Your camera monitors a parking lot from which a car had been stolen during the day. Follow these
steps to locate the event as quickly as possible:

1. Startthe Playback mode (right-click ) and select an interval (e.g., 1 day) o

2. Keep clicking on Previous imageo until the caris in the image.

O

4. Keep clicking on Next image until the car is not in the image any more.

3. Select a shorterinterval (e.g., Lhour ).

5. Keep on using shorter intervals, until you have found the exact point in time of the incident.

Note that you can also use the Forward/Backward Playback buttons to play back using
the same time leaps.
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Playing Back Recordings

Forward/back- One image forward/
ward playback backward

Playback speed

Up to 16x faster

Hint: Precise Positioning by Image

If you want to examine a scene very closely, you can check the recordings one image at a time. To
do so, stop the the playback (click on or ). Now use the two buttons (forward) and
(backward) to navigate the images one by one.

Hint: Playback Priority

To optimize the camera for fast playback, the Playback has Priority option has already been set.
You can change this setting in Setup Menu > General Image Settings > Playback has Priority.
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3.5.3 Searching and Playing Back in the Grid Playback
To show the Grid Playback, right-click on the Navigation button and select Grid Playback.

O

The Grid Playback provides synchronized searching and playback of the recordings of entire camera
groups.

1. Use the timestamp in the focus window o or the calendar slidere to set the time.
2. Drag&drop the desired camera group from the group bar.

3. Allcameras jump to the event image that is closest to the specified point in time. The timestamp
beneath each camera image shows the time and date of the image. The difference to the
reference time is shown at the right.

Hint:

You can also use the Grid Playback by dragging a group onto the Playback view. The original camera
will be shown in the focus window.
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3.5.4 Searching and Playing Back in the Research View

To show the Research view, right-click on the Navigation button and select Research o

- o

The Research view allows searching all event images of one camera or of the cameras of a group.
You can filter the events according to event types.

Showing the Event Images of a Camera/a Camera Group

Camera: Drag&drop the desired camera from the camera bar into the display area of the view.
Camera group: Drag&drop the icon image of the desired camera group into the display area of the view.
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Filtering by Event Types

Initially, the event images of the selected cameras are sorted by time. You can filter the events

according to event types (@J). To activate the event types, click on the corresponding buttons:
. : MxActivitySensor Events
. :Video Motion Events
. : PIR Events
. : Environment events: Noise, temperature, illumination, signal input
. :Ringing Events
. : Mailbox Messages
. : Door Station Events
. :Invalid RFID card
. :Invalid PIN

Marking Events

When browsing eventimages, you can right-click on an image and mark it as “important” .The
same applies to event images that you have marked as in the Playback view or in the Alarm bar
- you can see them in one collection in the Research view.

Playing Back Events

You can see the recording for each event directly in the view. To do so, move the mouse pointer over
the event image. Three icons appear.

« Clickon to show the recording.

« Clickon to switch to Playback.
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3.5.5 Playback Analysis: Searching With Post Video Motion Detection

Post video motion detection (Post VM) has already been added as a plugin in MxMC. This plugin
allows searching recordings for changes in one or more image areas of a camera. This is done with
the help of “motion windows”.

To open the Post video motion detection, right-click in the Playback view or in the Grid Playback
and select Post VM Detection.

O

Creating Motion Windows

1. Clickon in the image area on the right-hand side of the settings dialog o A new window
with a predefined video motion window opens.

2. You can execute the following commands:
+  Modify the size of the video motion window: By moving the sides or the corners of the window.
« Create additional video motion windows: Draw a new window with the mouse.
« Duplicate a video motion window: Click on
« Delete a video motion window: Click on
« Deactivate a video motion window: Click on

3. To close the editor window, click on in the top right corner of the window.
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Setting the Trigger Conditions
The Post VM windows allows setting different parameters that influence the detection results:

o Trigger Level: White bar in diagram e

Controls the trigger threshold of the video motion windows. Move the bar to the bottom to
recognize a movement if only a few pixels change from one image to the next. Move the bar
to the top to recognize a movement only if many pixels change.

. Sensitivity:
This setting controls how large the change of each pixel in a video motion window must be

to count as a movement. Together with a low threshold value, this setting can be used to
fine-tune video motion detection.

. Correct Changes in Illumination:
Activate this option to avoid false alarms, if lighting conditions change rapidly (e.g., sun and
cloudy sky).

. Deadtime:

This sets the timespan after the last Post VM event, during which pixel changes in a video
motion window are ignored.

. Median Value:
Enter a long duration (e.g., 2.0 sec.) to improve the detection of slow movements. Note: Setting
avalue that is too high can lead to smears in the preview window.

. Color Filter:

To limit the motion detection to a specific range or colors, select a color. If this color changes
during post video motion detection, the Post VM event will trigger.

Searching for Changes in Video Motion Windows

Once you have defined the video motion windows and have set the trigger conditions, you can
search the recordings for changes in the video motion windows. Use the playback buttons in the
command bar and proceed as described in ,,3.5.2 Searching and Playing Back in the Research View*
and in ,3.5.3 Searching and Playing Back in the Grid Playback*.

If MxMC detects a change within one of the video motion windows, the frame of that window turns
red and the search stops.
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3.5.6 Histogram With MxEventStatistics

The histogram in the Histogram bar illustrates the distribution of the event frequency and thus
provides a quick overview of the events of one or more cameras. You can open the histogram in the
Playback view and in Grid Playback by clicking on the dark gray frame border. To begin with, the
histogram always shows the entire range of the events logged by the camera.

Manual change of

time range
Set filter: Event type
or camera/group
Zoomed area
Overview area
Marker for displaying the
current time and to posi-
tion the corresponding
recording.
Time range for
which recordings
are available
Set the granularity
Define zoom area
Ker f Only show events,
Marker for that have triggered a
displaying the recording

current time and
to position the
corresponding
recording.

Manual change of
time range
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Displayed time range:

The timestamps at the top and the bottom of the histogram show the first and the last of the
available events logged by the camera, respectively. You can change this range manually. A
small cross at the left of the time range indicates that it has been changed manually. Click on
the cross to reset the timestamps to their original values.

Filtering:
You can filter the display by camera, by group or by event type. There two sliders for this

purpose: the group/camera slider and the event type slider. To set the filters, move the sliders
until you see the desired results.

Structure of the histogram:

- The histogram is split into the overview area and the zoomed area of the selected range in
the overview. Depending on the displayed timespan of logged events, the overview area
shows hours, weeks or months (as indicated by the unit).

- The pink bar indicates the time range, in which recordings for the logged events exist. Note:
Recordings may not exist for the entire timespan that is covered by the histogram.

- Theyellow scroll bar shows the range that is displayed in the zoomed area. Clickon  to
set the displayed time range in the zoomed area (e.g., custom, 6 hours or one day).

- To move the time range in the zoomed area, simply move the yellow scroll bar to the time
range you want to examine. If you have set the zoomed areato ~ “Custom”, you can modify
the displayed time range by dragging the frame of the scroll bar.

- If you want to see only events in the zoomed area that have triggered recordings, click on

Distribution of Frequency:

The length of the bars indicates the frequency of logged events per time unit. Click on if
you want to see more details on the distribution of frequency for a specific point in time. The
display switches to a higher resolution.

If you want to get more detailed information on a specific point in time with a high event
frequency, click on the interesting spot in the zoomed area or the overview area. The red
position marker jumps to the spot and shows a recording, if available. You can now play the
recording in Playback view.
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3.5.7 Retail System - POS Terminals With Integrated Video Surveillance

The MOBOTIX Retail system will link all cash point transactions with the video recordings of the
associated transactions in MxMC. It enables you to quickly find and review any suspicious activities.
The Retail bar and the Retail view are available for searching and analyzing transactions.

Before using the Retail system, you have to open the Preferences (MxManagementCenter > Preferences >
Retail System) and add the cash registers and determine the data source. For more information,
please see ,,3.9.1 Setting Options and Selecting Defaults, Retail System.

Retail Bar

The Retail bar provides a direct overview of the most recent transactions (from the last 24 hours)
and for this reason it is convenient to use it for reviews and searches.

1. Opening the Retail Bar

The Retail bar is available in all views. To open the Retail bar, click on the right frame border of the
application. The Histogram bar will appear. Click on the frame border again to switch to the Retail
bar. You can also open the Retail bar from the menu (View > Retail bar).

2. Using the Retail Bar
The Retail bar is automatically updated when the connected cash point transmits new data to the
camera. This enables live surveillance of the cash point.

« Displayed time range: The Retail bar only contains the data from the last 24 hours. You can
search data that is older than 24 hours in the Retail view.

« Search feature/Filter feature: You can filter the entries for each cash point’s camera by search
term. The hits are highlighted in yellow. You can jump to the next/previous search result using
the two arrows on the lower edge.

« Do not show system transactions: By default, the Retail bar shows all transaction that are
stored on the corresponding camera. Some of the transactions show purchases and events
that are directly associated with the purchases, such as the “Total sum.” Other transactions
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show only administrative events, such as when the cashier logs on. Click on to enable/
disable display of system transactions.

Do not group receipts: Transactions are grouped by receipt number or purchase by default.
Individual sales can be grouped if the cash point signals the conclusion of the transactions by
creating a receipt number. Counter sales can be grouped by counter if the counter is settled
in the cash point system. Click on to disable display by groups. The data will be reloaded.

Playback transactions: Open the Playback view by double-clicking on a transaction line. The
video recording to the transaction will be played back.

Searching Retail Data in the Retail View

You can search and filter data of one or more retail cameras in the Retail view.

1. Defining Search Queries

You can define and store several search queries. Enter a name for each search. The search query
will be automatically saved every time the search criteria are changed. This also happens when
individual search parameters and terms are changed.
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By default there is one search query already. Click on the tab and enter the desired name.

Select the desired cash points. You can select more than one or even all cash points for a
search query.

Specify the period of time for the search. You can also enter a period of time that allows you to
enter any start and end timestamp, in addition to a series of preset time windows (including
“today”).

You define the search criteria to limit the scope of the search once you have selected the cash
points and defined the period of time for the search. Click on to do so. A new line will be
inserted. The individual criteria can be linked using AND or OR. The logical search operators
can only be applied to all search criteria at the same time. Select ~ to link the search criteria
using AND and to link them using OR.
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Please note that the search criteria are only applied to individual transaction rows, e.g., a
search for a total > 100 and < 150. For the time being, it is not possible to apply the search to all
transaction rows of a receipt, e. g., the search for a specific item linked to the total amount > 100.

« Clickon to delete a search criterion.

« Clickon to define further search queries, in addition to the most recent search query. Enter
a name and repeat steps 1-5.

2. Deleting Search Queries

Click on to the left of the name for the search query to delete a search query.

3. Reloading Searches

Anew search is performed on the retail data on the camera with the filter when the search query is
reloaded. The search results are displayed again. Click on to reload a search query.

4. Displaying Search Results

The search results are displayed with preview images in a list with a detailed display of the cash
point data or in tiles, depending on the selected display format from the Command bar (List view
or Tileview ).

Search Results in Lists

The search results are displayed in the List view in a table in which the individual transactions are
entered with detailed information. Click on a transaction line to view the receipt data and a preview
image of the selected transaction.

1. Displaying Search Results

The most recently selected search query is automatically performed when you open the Retail view.
Click on the desired tab to perform a previously saved search. The search results are displayed in
the table as individual transactions.
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2. Displaying Receipt Data

Click

on arow in the table to select a transaction. The matching receipt data of the selected transaction

is displayed in the Receipt section.

Do not show system transactions

The transactions contain events that are directly associated with the purchase, such as the
total or subtotal. Some transactions also show administrative events only, such as when the
cashier logs on or off. The system transactions can be hidden in the table with the receipt data.
To do so, click on in the Title bar of the Receipt section.

3. Showing Preview Images

When you click on the row in the table, you do not only receive a display of the transaction data in
the Receipt section, but you also receive a preview image that belongs to the camera recording for
the transaction in the Preview Image.

Switch to Live view

To do so, move the mouse pointer over the preview image. Three icons appear. Click on
to switch to the Live view.

Playback recording for the transaction

You can either directly view the recording for the transaction in the tile of the preview image
(Instant Player) or you can switch to the Playback view and view it there. To do so, move the
mouse pointer over the preview image. Three icons appear.

« Clickon to activate the Instant player.
Hint: A click into the image after starting the playback opens the recording in full screen
mode in the current program window.

« Tosee the recording directly in Playback view, click on

4. Adding Individual Clips for Exporting

The Export bar provides a quick and easy way to create clips on individual retail transaction for
subsequent exporting (see section 3.6.3, ,Exporting From the Export Bar“). To do so, drag the tran-
saction preview image in the Preview Image section and drop it on the Export bar. The default clip
length is ten seconds on either side of the transaction timestamp, that is, for a total of 20 seconds.
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Search Results in Tiles

The individual search results are displayed in the Tile view as preview images. You can either directly
view the recording for the transaction in this preview image as an instant playback or you can switch
to the camera’s Playback view and view it there. In addition, you can switch to this camera’s Live
view directly from the preview image.

1. Switching to the Live view

To do so, move the mouse pointer over a preview image. Three icons appear. Clickon  to switch
to the Live view.

2. Preview Image Playback

You can either directly view the recording for the transaction in the tile of the preview image (Instant
Player) or you can switch to the Playback view and view it there. To do so, move the mouse pointer
over the preview image. Three icons appear.

« Clickon  toactivate the Instant player.
Hint: Aclickinto the image after starting the playback opens the recording in full screen mode
in the current program window.

» To see the recording directly in Playback view, click on
3. Adding Recordings for Exporting

The Export bar (see section 3.6.3, ,Exporting From the Export Bar*) provides a quick and easy way
to add clips for exporting. The default clip length is ten seconds on either side of the transaction
timestamp, that is, for a total of 20 seconds.
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3.6 Exporting Recordings

3.6.1 Saving Snapshots

Snapshot images can be created in the Live and the Playback views for the displayed camera, in
the Grid view and Grid Playback for all displayed cameras. Click on the Snapshot button in the
command bar.

By default, the images are stored on the desktop. Snapshots from the Grid view or the Grid Playback
are stored in a folder on the desktop that contains the images of all cameras of the group. To
set the target folder and image settings for the snapshot images, open MxManagementCenter >
Preferences > Snapshots in the menu.

3.6.2 Exporting Recordings
Exporting the Recordings of One Camera

The Playback view allows setting a time range for a recording (event or continuous recording) in
oder to select it for exporting.

1. Open the Playback view.
2. Drag&drop the desired camera from the camera bar.
3. Find the recording you are interested in.

4. Mark the start of the clip by clicking on the gray flag on the left. Play the recording until you
have reached the end of the clip you want to export. Mark the end of the clip by clicking on
the gray flag on the right. Both flags are now green .

° O

5. Click on Export o and select MOBOTIX.

6. Select a target folder in the Export dialog and enter a file name. Click on Save. The clip is
saved to the file.

Hint: Automatic Import
If you activate the Automatically import after export option, the exported clip is automatically
added to the camera bar.
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Exporting the Recordings of a Camera Group

The Grid Playback allows setting a time range for a recording (event or continuous recording) in
order to select it for exporting from several cameras.

1. Open the Grid Playback.

2. Drag&drop the desired camera group from the group bar.
3. Find the recordings you are interested in.
4

. Mark the start and the end of the clip as described in Exporting the Recordings of One Camera.

o O
(3]

5. Instead of exporting all cameras of this group, you can also select one or more cameras for
exporting. To do so, click and hold Export @J). A circle appears on the camera images in the top
left corner. To do so, select the desired cameras by clicking on the corresponding circles 3.

Note: The recording of the camera shown in the focus window will always be exported.

6. Export the clips as described in Exporting the Recordings of One Camera. Instead of in one
file, the program creates a folder that contains all exported clips.

Hint: Automatic Import
If you activate the Automatically import after export option, the exported clips are automatically

added to the group bar..
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3.6.3

Using
subse

Exporting From the Export Bar

drag&drop, the Export bar provides a quick and easy way to create a list of recordings for
quent exporting. From the bar, you can export recording time ranges as combined clips. You

can add the clips in the Playback view, in Grid Playback and in the Research view. Note that the
Export bar will not be deleted automatically after exporting, but only when closing the application.

Adding Clips for Exporting

Adding Clips for Exporting in the Playback View

1. Drag&drop the desired camera from the camera bar.

2. Find the recording you are interested in.

3.
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Mark the start of the time range by clicking on the gray flag on the left. Play the recording until
you have reached the end of the clip you want to export. Mark the end of the time range by
clicking on the gray flag on the right. Both flags are now green @). Of course, you can set the
end marker first (gray flag on the right), then play the recording backward and set the start
marker (gray flag on the left).

Click on the image of the recording and maintain the position until you see a scaled-down
image @@. Drag&drop this image to the Alarm bar (regardless of whether or not it is open).
The Alarm bar automatically turns into the Export bar, allowing you to place the image there.

Alternative: Activate the Alarm bar. Click on the lower frame border of the open Alarm bar.
The Export bar opens. Clickon . The selected time range will be copied to the Export bar..
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Adding Clips for Exporting in Grid Playback

The Export bar in Grid Playback is the best way to combine sequential time ranges of different
cameras. For example, you can use it to follow one person that passed several cameras.

1.
2.

5.

Drag&drop the desired camera to the focus window in the grid and find the relevant recording.

Mark the start and the end of the clip as described in Step 3, Adding Clips for Exporting in
the Playback View. The recordings of the other cameras will reposition accordingly.

Click on the image of the recording and proceed as described in Steps 4 and 5, Adding Clips
for Exporting in the Playback View.

Drag&drop the camera with the next recording in the sequence of events into the focus window.
Mark the start and the end of the clip as described above, then drag&drop the recording into
the Export bar.

Repeat these steps until you have added all recordings you want to export.

Note that you can also add recording time ranges from several cameras in the Export bar.

1.
2.

Simply drag&drop the desired camera group from the Group bar and find the relevant recording.

Mark the start and the end of the time range as described in Step 3, Adding Clips for Exporting
in the Playback View. The recordings of the other cameras will reposition accordingly.

Right-click on Export . A circle with a checkmark appears in the top left corner of the
recordings. If you do not want to use the recording of a specific camera, deactivate the recording
by clicking on the corresponding checkmark.

Click on the image of the recording and proceed as described in Steps 4 and 5, Adding Clips
for Exporting in the Playback View. The selected clips will be copied to the Export list.

Repeat these steps until you have added all time ranges you want to export.
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Adding Clips for Exporting in the Research View
In the Research view, you can add recorded event sequences to the list. The length of the event
sequences is currently 20 seconds.
1. Setfilters by camera, by group or by event type as needed.
2. Right-click on Export  .Acircle appears on the camera images in the top left corner. Mark
the desired events by clicking on the corresponding circles.

3. Open the Export bar (by clicking on the lower frame border of the open Alarm bar). Click on an
event image and maintain the position until you see a scaled-down event image. Drag&drop
this image to the Export bar. The clips of all selected event images are added to the Export bar.
Alternative: In the Export bar, click on . The clips of all selected event images are added
to the Export bar.

4. If needed, you can set new filters and add more event images to the Export bar.

Editing Clips

If you have added a recording to the Export bar, for which you had activated distortion correction
or zoom features during playback, you can choose to export the clip with or without zoom settings.
Likewise, you can export the clip with or without audio. To do so, move the mouse pointer over the
recording in the Export bar. Three icons appear:
. : Clip is exported with zoom.
Click on to export the clip without zoom. The icon is disabled.
. : By default, the clips are exported with audio (provided that audio had been recorded).

To export without audio, clickon . Theicon is disabled.

. : The clip is played back.
Note that you can review the clips before exporting by playing back individual clips directly
in the Export bar. Click on

Hint: Click on the recorded image to enlarge it.
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Exporting Recordings

To delete one or more clips, open the context menu by right-clicking on a clip. The context menu
provides information on the clip, such as the recording time range covered by the clip. In addition,
you can manually adjust the time range, activate/deactivate audio for all clips or duplicate a clip.

P1.1.11.5

Exporting

Click on Export , then select MOBOTIX to export an MXG clip. Select a different profile to create
an AVl file. Select a target folder in the Export dialog and enter a file name. In addition, you can
choose to automatically add the MXG clips of the Export bar to the Camera bar after exporting. To
do so, activate the Automatically import after export checkbox.
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3.7 Working With Different Network Environments

Using MxManagementCenter, you can access cameras from different locations. This usually means that
each location requires using different network access data. To avoid having to change the network
access data every time, you can set up different network environments with the corresponding
network access data.

3.7.1 Creating Environments

Create your environments to begin with. Next, use the Camera Configuration dialog to select the
cameras for each environment. This is also where you can set the DynDNS access for the cameras
(if you did not specify this when adding the cameras).

1. Inthe header bar, click on Projects and Environments o and then on Environment o

2. Click on Add 0 This adds an environment with the “New environment” default name. You
should change the name by clicking on Edit and entering a descriptive name.
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3.7.2 Changing Network Data and Selecting Environments

After creating the environments, you can select the cameras that will be active for each environment
and adjust the network data as needed.

1. Activate the edit mode by clicking on ﬂ at the bottom of the device bar. To open the the
Camera Configuration dialog right-click on the desired camera.

2. Select the environment o
3. Select the bandwidth to use for this environment: o
. HiRes: The images are transferred using the current camera settings.

. LoRes: The images are provided with the specified frame rate, image size and quality
(see “Program settings”).
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Selecting an Environment

1. Inthe header bar, click on Projects and Environments and then on Environment. Select the
desired environment.

O
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3.7.3 Temporarily Adjusting the Bandwidth

By assigning a bandwidth to an environment, you can specify how the images are pulled from the
cameras given different connection speeds. This basically controls how the images can be displayed for
live viewing and event research. Selecting a bandwidth thus also controls the image quality. Note that
you can temporarily overwrite the bandwidth setting without actually changing the camera setting.

1. Click on Bandwidth in the header bar.

2. Click on the button to switch from one setting to the next.
. HiRes: The images are transferred using the current camera settings.

. LoRes: The images are provided with the specified frame rate, image size and quality
(see “Program settings”).

. Unchanged: Uses the original setting of the camera.
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3.8 Working With Door Stations

3.8.1 Setting up Door Stations

In general, the door stations are configured when adding them to the system. Note that you can
change the bell behavior and the mailbox settings also while the system is up and running. You
can do this in the Live view in the bell and the mailbox settings. The settings apply to the currently
selected camera.

Bell Settings
Setting the Ring Tone

1. Open MxManagementCenter > Preferences and click on Notifications.

2. Select the desired melody and the volume.

Selecting a Bell Profile

A bell profile basically controls how the program reacts if someone is ringing at the door station.
The camera provides several pre-defined bell profiles:

« No phone ring: MxMC and all other remote stations will not react, i.e., you will not notice if
someone is ringing (neither visually nor by sound).

« Ringing: You will be notified about a ringing on the door station. The visitor cannot leave a
message.

« Ring and Mailbox: You will hear if someone rings the doorbell. If you do not react within a given
period of time, the door station plays back an announcement and the visitor can leave a message.

« Mailbox: After ringing, the door station immediately plays back an announcement and the
visitor can leave a message.

« Announcement only: After ringing, the door station immediately plays back an announcement.
The visitor cannot leave a message.
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Working With Door Stations

1. Inthe Live view, right-click on the Bellicon to open the Bell Settings

2. Click on Bell Profile and then click on the desired profile in the list.

O

The counter on the bell button in the Live view is incremented upon every ringing of the doorbell
regardless of whether you react to the ringing, or not. Resetting the counter will help in recognizing
if you have missed a ringing, you should therefore always reset the counter to Zero. Once you have
reset the counter, the menu item will show the date and time the counter has been reset.

Reset Counter

1. Click on Reset Counter.

2. The counter has been reset and will not be shown next to the Bell Settings button.

Deactivating the Doorbell Completely

If you do not want to be disturbed by the doorbell, you can deactivate a specific bell or contact
number. This means that the ringing of the doorbell will neither be indicated nor registered at the
door or at one of the door stations. It also means that you will not get any information about visitors
you missed and visitors will not be able to leave messages.

1. Inthe Live view, right-click on the Belliicon to open the Bell settings.

2. Deactivate the Bell checkbox.
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Mailbox Settings
Select Mailbox

Depending on the installed options and the configuration of the door station, you may have several
bell buttons or - in case a MOBOTIX keypad module has been installed - several contact numbers.
Each of these bells or contact numbers has its own mailbox. The corresponding mailboxes are
presented in the list (below the name of the bell).

Note: All settings made in the Mailbox function always apply to the selected mailbox. This also
means that the new messages counter only applies to this mailbox. To get the messages and record-
ings of a different mailbox, select that mailbox first.

O

1. Inthe Live view, right-click on the Mailbox icon to open the Mailbox settings
2. Click on Mailbox o to select the desired mailbox from the list.

Proceed by selecting a bell profile for each mailbox. For instructions on how to do this, see “Selecting
a Bell Profile”.

Activate the Mailbox and Select a Welcome Message

Activate the mailbox e Select the message that will be played to the visitor o

Enable the Message

If visitors should be allowed to leave a message, activate the Leave Message option o
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Working With Door Stations

3.8.2 Operating Door Stations

Answering Ringing

There are different ways to indicate that someone has rung the doorbell.

Alarm bar The Alarm bar turns green.
Alarm info bar The Alarm info bar turns green in the live images.

Doorbell message A blue dialog box appears with the live image of the door camera.
You can start a conversation and open the door directly.

Counter on the bellicon  The red counter on the bell icon is incremented by one.

The following table describes which signaling options can be combined and where these can be
set. Please note that alarm notification must be activated and a bell profile set up in order for the
bell notification to work.
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Notifications Setting options

Alarm bar, For the doorbell to ring at these places, you need to configure the
Alarm info bar, Alarm signaling.

Door bell message, 1. Open the Camera Configuration dialog by right-clicking on
Belll e cEuTED the corresponding camera in the Camera bar.

Another option is to open the dialog box in the Device bar by
clicking [ and then right-clicking the corresponding camera.

2. Click Alarms and activate the Alarm notification and set ringing
events to be alarm events by activating the Ringing checkbox.

O

See also section ,Setting Alarm Filters and Alarm Notifications*

Bellicon counter only Deactivate Ringing in the Alarms dialog box and only the counter on
the bell icon will increase by one each time a ringing event occurs.

1. Open the Camera Configuration dialog by right-clicking on
the corresponding camera in the Camera bar.

Another option is to open the dialog box in the Device bar by
clicking {7} and then right-clicking the corresponding camera.

2. Click Alarms and deactivate the Ringing checkbox.

Bell sound off You can deactivate the bell sound in Notifications (Mac menu
MxManagementCenter > Preferences, Windows menu File >
Preferences) by setting the volume to ,,0“

Completely off Deactivate the Bell checkbox in the Bell Settings  to switch off

the bell completely.

See also section ,,Deactivating the Doorbell Completely*
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Opening the Door/Switching Lights

If the door station has been set up properly, you can use MxManagementCenter to open the door
and to switch the lights. Use the buttons in the command bar of the focus window (Grid view) and
in the command bar of the Live view.

Grid View

Live View

Playing Back Door Station Events

Playing Doorbell Recordings

If you have missed a visitor, you can use the Alarm bar to see who rang the doorbell and when that
happened.

1. To do so, move the mouse pointer over the event image. Three icons appear.
2. To see the doorbell recording directly in the Alarm bar, click on Play

3. Tosee the doorbell recording directly in Playback view, click on Playback

Accessing the Mailbox Messages

If visitors have left messages during your absence, you will immediately notice the counter next to
the Mailbox button in the Live view, which is incremented every time someone leaves a message.
Onceyou have played back the message in the Playback view, the message is automatically marked
as “seen” and the counter is reduced by one.
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3.9 Program Settings

3.9.1 Setting Options and Selecting Defaults

Open MxManagementCenter > Preferences in the menu.

General Settings

« Language: Sets the program lan-
guage. You may have to restart
the software in order to apply your
changes.

« Behavior: Deactivate this option to
prevent that a double-click switches
to full-screen image on the main
monitor or on other monitors.

« Graphic Mode: If you want to correct
hemisphericimages, make sure that
this option has been activated. A pre-
requisite for using this feature is a
graphics adapter with OpenGL V2.1
support, since it performs the actual
distortion correction. Deactivate
OpenGL if your graphics adapter
does not support this mode or if you experience problems when displaying the camera images.

« Recording Path Cache Sizes: To improve the playback performance, you can set the internal
cache size for playback. This applies to both types of playback - via camera or directly from a
file server. Please be aware that the cache size set here will reduce the available RAM for other
processes, which in turn can influence the performance of other applications.

« Display Area: If you are working with the Camera/Group bars or the Alarm/Export bars, you
can change the width of the bars. Use this option to automatically resize the display area in
such a case.

Software Update

MxMC can use the update feature to
automatically search for new program
versions. This function requires an Internet
connection. Adjust the update request to
suit your needs.

Note that you can also start the search
manually. To do so, click on Search Now.
If a new program version is available, you
will see this here.
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Data Volume

« Bandwidth: By using environments
(see Section 3.4, «Working with Different
Environments»), the images can be
pulled from the cameras with differ-
entsize, quality and frame rate. You
can limit the bandwidth by adjusting
the values for LoRes connections. By
using lower values, you can limit the
bandwidth required to transfer the
data, thus allowing you to adapt the
system to the connection speed.
Default values for LoRes: 1 fps, CIF,
30%.

Note that these settings are by no
means camera settings; you are only
limiting the frame rate, image size

and quality of the video stream that is transferred to MxMC. If you set a value that is higher

than the value set on the camera, the camera value will be used.

o Maximum Number of Events/Maximum Time Range: The number of events and the time range
are controlling how far into the past MxMC will look for event information after the next launch
of the application. The settings apply to the event counter in Live view and the event preview
images in the Research view. This avoids long loading times and saves storage space when
initially loading the event information. Note that you can load additional images, if required.

Setting the Intercom Mode of Door Stations

Use the slider to set the sensitivity for
transmitting the sound from the camera
microphone. The default setting has been
optimized for Intercom connections and
should only be changed in very noisy or
very quiet door station surroundings.

Hands-Free Talking and Push to Talk
The Hands-free Talking option is activated
by default. If the surroundings are very
noisy or if audio connection problems
persist, you should try to use the Push
to Talk setting.
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Snapshots

You can save snapshots from live images or from
recordings. These settings control the location
and the quality of the snapshot images stored
by MxMC. If you do not specify a folder, the files
will be created on the desktop (see Section 3.6.1,
«Saving Snapshots»).

Monitoring

Lost Connections

If the connection to a camera is lost (e.g.,
due to a network failure or changed camera
access data), the application can show a
warning. This is where you configure the
warning. Activate the Lost Connection
Detection checkbox and specify how you
want MxMC to react if the connection to a
camerais lost (warning sound and window).

Remote Control

MxMC can be remote-controlled from other
programs using HTTP requests. Activate this
feature and set a proper port if you want to
use this feature. Click on one of the example
links to see a list of executable commands.
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Recording Paths

The program can access the stored images using two methods: Access via the camera (remote
playback) or directly on a file server, on which the recordings are stored. If you want to directly
access the recordings, you can create recordings paths, which can then be assigned to the cameras
(Camera Configuration dialog). Direct access allows using extremely high playback speeds (up to
60x the regular speed).

Name
The name of this path will be shown in the camera configuration dialog when selecting a recording path.

Type
e Local:
Contains a local folder on this compu-
ter or on a connected network drive.
You can either enter the folder path
manually, drag&drop a folder to the
text box or select the folder.

Path: Make sure that the path ends
before the folder containing the factory
IP address of the camera.

* Network Share:
The program directly accesses a shared
folder on a different computer. In this
case, you need to enter the computer,
the folder and the access data.

File Server (IP):1P address or DNS name
of the computer with the share.

Directory:Name of the share on the com-
puter (optionally followed by additional
folders). Important: Make sure that the
path ends before the folder containing
the factory IP address of the camera.

User Name/Password: Access data for
accessing the network share.
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Joystick PTZ

You can adapt the joystick behavior to your personal requirements. Start by setting the PTZ type,
then set the behavior for each axis.

PTZ Type

« Screen PTZ: The PTZ actions are
taking place in the application.
This means that only the visible
image section of the current live
image is modified. Any zooming
does not influence the recordings
of the current camera image that
may be taking place.

« Camera PTZ: Zooming will be per-
formed on the camera and can also
influence the recordings (but only
if the camera does not record the
fullimage).

« External PTZ: If you are using the
camera of a different manufacturer, you can set its joystick behavior in this dialog.

Axes
« X Axis: Horizontal movement
« Y Axis: Vertical movement
« ZAxis: Zooming

Invert

Use this option to invert the actions by the joystick for that axis.

Sensitivity

If the PTZ actions are reacting too slowly, you can increase the sensitivity. If the reactions are too
fast, reduce the sensitivity.

Progression
Click on the[_Ibutton to change the progression of the joystick movements. The default setting is
linear progression.
« [ILinear: Default setting
. [ Logarithmic: Use this progression if you want to make the joystick less sensitive to small
input movements.
. Exponential: Use this progression if you want to make the joystick more sensitive to large
input movements.
Calibrate Joystick
Before adjusting the behavior, it is recommended to calibrate the joystick.
This will determine the basic settings of the joystick (behavior and speed).
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Retail System

In order to use the Retail system, a special script for MOBOTIX cameras must first be installed and
adapted at the Vectron cash register. This script ensures that the cash register can transfer its transaction
data to a MOBOTIX camera (Mx6 model with firmware V5.0.2 or higher). The POS integration must
be activated on the MOBOTIX camera

that is to receive the transaction data

and the name of the cash register must

be entered.

In the Preferences of the MxMC, you then
add the cash register and determine its
data and video sources.

o Discription: Name of the cash
register as it is displayed in MxMC.

« Name: Cash register name (with-
out spaces) as defined in the POS
configuration.

» Data Source: Select the camera
that receives the messages from
the POS system and saves its data.

o Video Source: Select the camera
that provides the appropriate recordings for the transaction data. This can be the same or a
different camera than the data source.
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3.9.2 Saving and Loading Program Settings

Saving a “project” will store all program settings of the cameras and the camera groups, including
the layouts. If you provide such a project via email, you can choose to include the encrypted access
data for each camera (user name and password). If you do not supply the access data, the user name
and password will have to be entered manually for each camera.

Saving a Project
1. Inthe header bar, click on Projects and network environments

2. Click on Save As.
3. Activate the Include access data checkbox if you want to include the camera access data.
Click on Save.
Sending Projects
1. Inthe header bar, click on Projects and network environments
2. Click on Email To.
3. Activate the Include access data checkbox if you want to include the camera access data. Click
on OK. The file is automatically attached to a new email. Send the email.
Opening a Project
1. Inthe header bar, click on Projects and network environments

2. Click on Open and select the project file. Decide whether the current project should be saved
or not.
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3.9.3 Activating/Deactivating the Privacy Mode

You can lock or deactivate specific functions of a camera for a certain period of time. This is easily
done by activating the privacy mode. This mode is valid for 24 hours unless you deactivate it before.

1. Inthe Live view, right-click on the Alarm icon to open the Alarm settings.
2. Click on Privacy 0

3. Activate the features that should be blocked when entering the Privacy mode. Activate the
Privacy switch .

4. Deactivate the Privacy switch if want to stop this mode. The privacy settings will be stored
and will be reused the next time you are activating this mode.

Note: If the Privacy mode icon appears in the top right corner of the camera image, this mode
has been activated.
3.10 Opening the Action Log

MxMC can log any action, such as starting playback or export actions, activating the sound, etc.
This means that you can log all user actions and thus deliver the entire chain of evidence for legal
purposes. To open the action log, select Windows > Action Log in the menu.
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4  Appendix

4.1 Key Combinations: Overview

Program commands that are available via menu items can also be carried out by key combinations.
This includes commands such as opening specific views or showing/hiding specific bars (device
bar, histogram bar, etc.). Usable key combinations for these actions are shown in the various menu
items, e.g., the View or Navigate menu item.

In addition, there are some useful key combinations for functions that are not available via the menu:

Key combinations Explanation

CMD-Shift-L (Mac)

. . Opens the currently displayed camera in the browser.
STRG-Shift-L (Windows)

CMD-Shift-A (Mac) Opens the Admin menu of the currently displayed camera in the
STRG-Shift-A (Windows) browser.

CMD-Shift-Y (Mac) Opens the Setup menu of the currently displayed camera in the
STRG-Shift-Y (Windows) browser.

CMD-R (Mac) Reloads the connections to all cameras that are relevant to the
STRG-R (WIndows) current view.

Reloads the connections:
CMD-ALT-R (Mac)

STRG-ALT-R (Windows)

« to all cameras that are relevant to the current view and
» to all cameras with active Background Alarms.

Pressing the Shift key while starting the application prompts MxMC
to show the Live view without displaying any cameras. You can
use this key combination to return to a safe state in case there is
arecurring problem or instability with the camera while starting
the application.

Shift key (when starting the
application)

S+C+R keys (when starting

el Empties all project data and starts the application from scratch.

Starts and stops the playback in the Playback view and the Grid

Sl Playback

Plus/minus key Increases/decreases the playback speed while playing back recordings.
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